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Preface 

  
 
The Area Change Tool (ACT) was developed in response to the need for a tool that 
could be used to help design and delineate fuel and vegetation prescriptions as well as 
edit raster layers to accurately portray treatment outcomes.  These edited data can be 
used with fire behavior analysis systems such as FARSITE (Finney 1998) and FlamMap 
(Finney and others, 2006) to evaluate the effectiveness of proposed fuel or vegetation 
treatments.  However, since ACT is simply a geographic information system (GIS) tool, 
its potential applications can include any GIS analysis that involves: 
 

• Creating a new shapefile  
• Editing an existing shapefile  
• Converting the attributes of a shapefile into a raster 
• Combining multiple rasters into a single raster 
• Editing the value attribute table of a raster 
• Converting edited attributes into a new raster 
• Merging an edited raster layer into the original raster layer to create a new 

layer that incorporates the edits  
 
This version of the Area Change Tool (version 2.0.3) was released in January 2008.  
Future versions will incorporate additional features, so be sure to check the NIFTT 
website at www.niftt.gov for tool updates and enhancements as well as associated 
updates to this user’s guide. 
 

 

What’s new in version 2.0.3? 
 
The original version of the Area Change Tool contained two user interfaces: a Wizard 
Interface and a Toolbar Interface.  The Toolbar Interface has been removed to eliminate 
redundancy and to reduce complexity.   
 
We have also changed some of the terminology used in the ACT dialog boxes for added 
clarity. 
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Prerequisites 
 
The Area Change Tool uses ArcGIS (including ArcMap and Spatial Analyst), Microsoft 
Windows, Microsoft Excel, and Microsoft Access.  Users need a basic understanding of 
these software packages in order to successfully process data using the Area Change 
Tool. 
 
The specific hardware and software requirements for operating the Area Change Tool 
are described in Chapter 1 of this user’s guide. 
 
 

Obtaining copies 
 
To obtain additional copies of this ACT User’s Guide or to obtain the ACT Tutorial 
(available spring 2008), follow these steps: 
 

1. Go to the NIFTT website at www.niftt.gov.  
2. Click on NIFTT Tools and User Documents in the menu.  On that page, 

select NIFTT User Documents. 
3. Click on the material you wish to download. 
 

 

Credits 
 
The Area Change Tool was developed for the National Interagency Fuels Technology 
Team (NIFTT) by Lee Hutter of Systems for Environmental Management (SEM), 
Missoula, Montana. Direction was provided by Jeff Jones and Wendel Hann from the 
USDA Forest Service and Marc Levesque of Acadia West, Silver City, New Mexico.  
 
Support for the development of ACT was provided by the USDA Forest Service and the 
U.S. Department of Interior.   
 
This Area Change Tool User’s Guide was written by Jeff Jones of the USDA Forest 
Service and Deb Tirmenstein of Systems for Environmental Management. 
 
Lastly, we thank Christine Frame of Systems for Environmental Management for her 
editorial proficiency.   
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Your input 
 
We value your input.  Please forward any questions, comments, reports of bugs, or 
ideas to the National Interagency Fuels Technology Team (NIFTT) at 
helpdesk@niftt.gov. 
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Chapter 1:  About the Area Change Tool (ACT) 
User’s Guide 
 

 
1.1  Before you begin 
1.2  How to use this guide 
1.3  System requirements 

1.3.1  Computer hardware  
 1.3.2  Computer software  

 

 

1.1 Before you begin 
 
As mentioned, ACT users must be familiar with Microsoft Windows and have at least a 
basic understanding of ArcGIS operations, including a working knowledge of ArcMap 
and the Spatial Analyst extension.  If ACT is used for editing raster data, users must be 
familiar with editing data in either Microsoft Excel or Microsoft Access.  For help with 
ArcMap or Spatial Analyst, please refer to ArcMap’s help utility.   

 
 

1.2 How to use this guide 
 
You need not read the entire guide from front to back to carry out a specific task in 
ACT.  Once you are familiar with the basic concepts associated with ACT, you can 
quickly locate commonly used tasks by referring to headings in the Table of Contents 
near the beginning of this guide.  You can then go to the specific section that addresses 
your needs.  Whenever possible, screen captures are used to illustrate the steps to 
complete a required task.   
 
Note that the ACT User’s Guide is intended to provide step-by-step guidance on the 
operation of the tool and serves as a reference guide. The ACT Tutorial, available spring 
of 2008 at www.niftt.gov, will provide specific examples of the use of the tool.  
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1.3 System requirements 
 

1.3.1 Computer hardware  

 
Your choice of hardware will greatly affect ACT’s performance.  In general, 
computers having faster processors, more memory, and more free hard drive 
space will process data faster.  A computer system having the minimum 
requirements identified in table 1-1 will likely suffice for applications involving 
relatively small analysis areas, such as tens of thousands of acres.   However, a 
computer system should have the recommended requirements (table 1-1) if 
users will be frequently processing relatively large analysis areas, such as 
hundreds of thousands of acres.   
  
 

Table 1-1. Minimum and recommended computer specifications for ACT. 

 Minimum Recommended 
Windows operating system 2000/XP 2000/XP 
Memory 1GB At least 1.5GB 
Processor: P4 or equivalent 1.0GHz At least 2.0GHz 
Free hard drive space 5GB             At least 10GB 
Display resolution 800 x 600 At least 1280 x 1024 
Mouse or pointer Required Required 

 
 

1.3.2 Computer software  

 
ACT users need ArcMap versions 9.0 or 9.1 and the Spatial Analyst extension. 
 

Note: ACT has not yet been tested with ArcMap 9.2 or with the Microsoft 
Windows Vista operating system. 
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Chapter 2:  ACT Function 

  
 
2.1 What does ACT do? 
2.2 Applications of ACT 
2.3 How does ACT work? 
 
 

2.1 What does ACT do? 
 
ACT is a GIS tool that facilitates the combining and editing of raster data using ArcMap 
versions 9.0 and 9.1.  It does nothing that cannot be accomplished using ArcView or 
ArcInfo Workstation.  However, ACT completes these tasks from the ArcMap platform 
and uses Microsoft Excel or Microsoft Access to edit the attribute tables of raster 
layers.  Moreover, ACT allows you to maintain logical relationships between raster 
layers by combining them first into a single layer so that multiple attributes can then be 
edited simultaneously.   
 
ACT incorporates seven GIS functions that are commonly used for editing raster data.  
These include: 

• Delineating new shapefiles (for example, identifying a project boundary) 
• Editing shapefiles (for example, identifying various treatment units within a 

project boundary) 
• Converting shapefile attributes to raster layers 
• Combining multiple rasters into a single layer 
• Editing the value attribute table of a combined raster  
• Creating a new raster layer from an attribute of an existing raster layer 
• Merging edited values back into the original raster layer 

 
 

2.2 Applications of ACT 
 
In general, ACT is useful for GIS applications that involve:  
 

• Editing incorrect raster layers  
• Updating raster layers to reflect recent disturbances such as wildland fire, 

insects, disease, or weather 
• Changing raster layers to reflect post-treatment outcomes  
• Characterizing conditions at the pixel level based on multiple attributes 
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• Deriving a new thematic layer based on a combination of multiple existing 
layers 

• Prioritizing treatment areas on the basis of layers created from a 
combination of attributes 

 
The following discussion illustrates several of the more common applications of ACT. 
 
For efficiency, GIS layers representing many ecosystem components such as biophysical 
settings, vegetation, fuels, soils, and climate are commonly modeled across relatively 
large geographic extents (millions of acres).  Users of these data frequently attempt to 
“make them better” by refining layers at a more local level.  Unfortunately, the process 
of editing raster layers can prove complicated for GIS users.  However, even less-skilled 
GIS users will be able to make changes to raster layers using ACT.  For example, 
suppose a fire behavior analyst believes that an existing fuel model layer is limiting his or 
her ability to simulate observed fire behavior on an incident.  The analyst can use ACT 
along with ancillary data layers such as aspect, slope, and cover type to modify the 
existing fuel model layer to more closely simulate actual observed fire behavior.   
 
The simple fact that ecosystems are dynamic necessitates frequent updates to GIS data.  
Wildland fires, wind storms, floods, insects, disease, and anthropogenic activities are 
constantly modifying vegetation structure and composition as well as landscape patterns.  
Consequently, vegetation and fuel data layers need to be updated on a continual basis to 
reflect changing conditions.  ACT can be used with disturbance layers (for example, 
burn severity data) to change vegetation and fuel data layers to reflect post-disturbance 
conditions. 
 
ACT can be used to evaluate the effectiveness of proposed vegetation and fuel 
treatment prescriptions in meeting management objectives.  ACT can be used to change 
the raster layers so that they reflect the outcome of the proposed treatment.  The 
edited layers can then be fed into modeling systems that forecast potential fire behavior, 
wildlife habitats, ecosystem departure, or other layers of interest.  That is, the post-
treatment conditions can be used to evaluate the effectiveness of the treatment. 
 
By combining multiple raster layers into a single layer, data can be integrated at the pixel 
level.  GIS modelers commonly derive a thematic layer based upon the combination of a 
suite of layers.  For example, some wildlife habitat layers may be derived based on the 
spatial coincidence of elevation, aspect, cover type, diameter class, and canopy cover.  
ACT can be used to combine these layers and then used to classify the habitat of 
interest.  In other words, ACT can be used to derive or model a new thematic layer 
based on some combination of existing layers. 
 
The integration of a suite of variables at the pixel level allows for a speedy diagnosis of 
concerns, identification of opportunities, and development of general prescriptions for 
treatment.  As many as 20 rasters can be combined to generate a value attribute table 
where each record (value) represents a unique combination of the input layers.  Having 
information on up to 20 layers represented on every given pixel can be powerful.  For 
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instance, ACT can be used to characterize each pixel by biophysical setting, existing 
vegetation (cover type, size class, or canopy cover), existing fuels (fire behavior fuel 
model, canopy base height, canopy height, or canopy bulk density), and likely fire 
behavior given some environmental parameters (for example, fuel moisture and wind).  
The combined layer could then be used to identify treatment opportunities and help 
design treatment prescriptions. 
 
Predicting fire behavior using FlamMap (Finney and others 2006) and FARSITE (Finney 
1998) requires a landscape area defined by the combination of elevation, slope, aspect, 
fire behavior fuel model, canopy base height, canopy height, and canopy cover.  Fire 
behavior is then predicted on the basis of these layers combined.  Since several of the 
themes in this example are interrelated, it may be important to retain the logical 
relationships between them.  Therefore, if a user wants to model fire behavior but 
believes that the fire behavior fuel model layer needs refinement, it may be necessary to 
modify the canopy cover, canopy base height, and canopy bulk density layers so that 
they are logically consistent with the fuel model layer.  In other words, a change in one 
variable, for example fire behavior fuel model, may require changes to other related 
variables such as cover type, size class, canopy base height, canopy cover, and canopy 
bulk density.  ACT can be used to edit the values of multiple layers simultaneously, 
thereby maintaining the logical relationships between the layers.    
 
ACT can be used to develop spatial priorities by identifying areas where a combination 
of conditions occur.  For example, fuel treatment polygons can be delineated around 
areas where passive or active crown fire would likely occur in conjunction with specific 
fire behavior fuel models, canopy base height values, and canopy cover values.  If 
managers are limited to using mechanized equipment to treat fuels and vegetation, the 
selection criteria could be further limited using thematic layers denoting slope and 
distance to open roads. 
 
 

2.3 How does ACT work? 
 
ACT uses a Wizard interface to guide the user through a sequential process for 
delineating vegetation and fuel treatment polygons, combining raster data layers that 
may need to be changed to reflect treatment objectives, editing the value attribute table 
to reflect treatment outcomes, and creating new updated raster layers.  Although the 
Wizard interface uses a linear process that links multiple GIS processing steps together, 
that process need not be followed.  Any of the GIS tasks performed by the Wizard can 
be selected at any time.   
 
ACT contains two options for changing raster layers: Uniform Change and Variable 
Change.  The Uniform Change is used when all values of a given layer within a polygon 
are changed to a single value (fig. 2-1).  The Variable Change option is used when the 
desired edits would result in multiple values within a polygon (fig. 2-2).  For example, 
suppose you have an existing fire behavior fuel model layer that follows Anderson 
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(1982).  After the fuel model layer was produced, you were provided with a detailed 
map of exotic annual grasses that you believe should be classified as FBFM-1 (Short 
Grass Model).  Consequently, you want to change to FBFM-1 all of the values in the 
existing fuel model layer that coincide with the polygons denoting exotic annual grasses.  
In this example, you could easily make these edits using ACT’s Uniform Change option 
since only one value is being assigned to the polygons (fig. 2-1).  However, if you want 
to update a fuel model layer after a wildland fire on the basis of three classes of burn 
severity (for example, low, moderate, and high), then the Variable Change option could 
be used to assign different fuel models on the basis of pre-burn conditions and burn 
severity class (fig. 2-2). 
 
 

 

a)  Existing fuel model layer 

 

 

b)  Exotic annual grasses 

 

 

c)  Modified fuel model layer 

 
Figure 2-1. Using the Uniform Change option to change the fire behavior fuel models based on 
areas mapped as exotic annual grasses. 
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a)  Fuel models: pre-burn 

 

 

b) Burn severity 

 

 

c) Fuel models: post-burn 

Figure 2-2. Using the Variable Change option to update a fuel model layer based on burn 
severity data. 

 
 
ACT contains two options for editing a raster layer’s attribute table when the Variable 
Change option is selected.  Microsoft Excel can be used to edit relatively small or 
homogeneous areas when the number of unique values or records is low.  However, 
combining multiple raster layers into a single layer may result in a value attribute table 
with several thousand unique values.   Using Excel to edit a table of this size can be very 
tedious.  For these situations, edits can be made more efficiently by using Microsoft 
Access, which enables you to write queries that will change hundreds of records 
simultaneously. 
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Chapter 3:  Installing ACT 
 

 
3.1 Installation instructions 
 3.1.1 Installing the complete NIFTT tool package 
 3.1.2 Single tool (ACT) installation 
3.2 Troubleshooting ACT installation 
 
 

3.1 Installation instructions 
 
Currently, all NIFTT tools can be installed at once as a package.  For some NIFTT tool 
users, the complete or package installation is most convenient.  
  

Note:  The following instructions apply to installation of the entire NIFTT package.  
Single tool installation will be addressed later in this chapter. 

 
Before you begin installation, it is important to note that both Microsoft .Net, Microsoft 
.Net Framework 1.1 with Service Pack 1, and the Hotfix are required for all of the 
NIFTT tools.  If you have only Microsoft .Net Framework 1.1, you need to upgrade to 
Service Pack 1 and the Hotfix.   
 
You can obtain Microsoft .Net Framework 1.1 by searching at 
http://www.microsoft.com.  
 
The folder dotnetfxsp1 contains three required files, and they must be installed in the 
following order (the install programs provide help in the form of warnings): 
 

1. dotnetfx.exe ( Microsoft .Net Framework 1.1).   
2. NDP1.1sp1-KB867460-X86.exe – (Microsoft .Net Framework 1.1 Service 
    Pack 1).   
3. NDP1.1sp1-KB886903-X86.exe - (Microsoft .Net Framework 1.1 Hotfix). 

     
You will need to reboot after installation.  However, only one reboot is necessary. 
 

Note:  To confirm that these programs are installed on your computer, check 
Add/Remove Programs.  You should see the following if the necessary programs are 
present: 

 
• Microsoft .Net Framework 1.1 
• Microsoft .Net Framework 1.1 Hotfix (886903) 
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Note: There is no indication given that Service Pack 1 is present except that Hotfix will 
not install unless Service Pack 1 has already been installed.  

 
 

3.1.1 Installing the complete NIFTT tool package 

 
If you have earlier versions of any of the NIFTT tools (Fire Behavior Assessment 
Tool [FBAT], Fire Regime Condition Class Mapping Tool [FRCCmt], Multi-scale 
Resource Integration Tool [MRIT], or the Area Change Tool [ACT]) installed on 
your computer, you will first need to un-install these tools before proceeding 
with installation of the current versions.   
 
To determine which version is currently installed on your computer, go to Start 
> Control Panel > Add or Remove Programs.   View the version of the 
NIFTT tool you are interested in (fig. 3-1). 

 

 

 
Figure 3-1. Version 2.0.3 of ACT. 

 
 

Note:  NIFTT naming conventions are as follows:  ACT_ 203_070215 
indicates that this “install” is version 2.0.3 which was completed on 
02/15/2007. 

 
You may need administrative privileges to install the NIFTT tool package.  
Contact your system administrator if you experience problems with the 
installation. 
 
Follow these steps to install the complete NIFTT tool package: 
 
1. From the NIFTT website at www.niftt.gov, click on NIFTT Tools and 

User Documents in the menu. On that page, select NIFTT Tools.  
2. Click on the NIFTT Install Executable file (FBAT, FRCCmt, MRIT and ACT) 

as shown in figure 3-2. 
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Figure 3-2. Downloading the complete NIFTT tool package. 
 
 

3. Next, double-click on NIFTT_Install_070226.exe to begin downloading 
the most recent tool installation package (note that the date in the file name 
may have changed).  You will see the dialog box shown in figure 3-3: 

 
 

  

Figure 3-3 Opening and preparing to download package 
installation file. 
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4. Click OK to download the installation file and then save it to a convenient 
location on your computer. 

 
 

The following box will open as soon as the download is complete. 
 
 

 
 

Figure 3-4. WinZip Self-Extractor NIFTT install dialog box. 
 
 

5. Unzip the file to either the default location (C:\NIFTT as shown above in 
figure 3-4) or the location of your choice by selecting the Browse button.   

 
Note: Do not install the tools to any pathways that may contain a space in the 
folder name such as My Documents or Program Files. 

 
6. A folder labeled NIFTT_Install_070123 will be created within the NIFTT 

(default) folder.  Locate and then double click on the folder labeled 
NIFTT_Install_070123 as shown in figure 3-5 to begin the installation 
process. (Again, dates in folder names may have changed.) 

 
 

   

Click on the 
NIFTT_Install 

folder 

 
Figure 3-5. NIFTT_Install folder 
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7. When the NIFTT_Install folder opens, you will see the following files.  Next, 
double-click on the installation batch file NIFTT_setup.bat.  

 
 

 

Click on the 
NIFTT_setup.bat file 

 
Figure 3-6. NIFTT Install folder contents. 
 

 
8. You’ll see a number of dialog boxes such as the one in figure 3-7.  Click Yes 

to install the Microsoft.NET Framework package. 
 
 
 

 
 

Figure 3-7. Microsoft Framework Setup dialog box. 
 
 

9. Follow instructions as directed in a series of tool installation screens.  Finally, 
you’ll see the following dialog box: 
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Figure 3-8. Microsoft Service Pack dialog box. 
 
 

10. Click OK to install the Microsoft.NET Framework Service Pack 1, which is 
necessary for proper operation of the NIFTT tools. 

 
11. You will be directed to reboot your computer after installation of each 

service pack.   However, do not reboot the first time you see the following 
message box: 

 
 

 
 

Figure 3-9. Microsoft .NET Framework dialog box. 
 
 

12. When prompted a second time, click Yes to reboot.   
 

Note:  If for some reason you do not see a second message box asking if you want 
to reboot your computer, reboot your computer after the installation is complete.   
 
In addition, during installation of the MRIT tool, you may be asked to specify 
whether the tool is to be installed for “Everyone” or “Just Me.”  Select the radio 
button next to the Just Me option.   

 
Installation of the NIFTT tool package should now be complete.  The following 
NIFTT tools should now be installed on your computer:   

 
• Area Change Tool (ACT) 
• Fire Behavior Assessment Tool (FBAT) 
• FRCC Mapping Tool (FRCCmt) 
• Multi-scale Resource Integration Tool (MRIT)   
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Two other applications, Microsoft.NET Framework and the Microsoft.NET 
Framework1.1Service Pack 1, should now also be installed. 

 
Note:  For NIFTT tools to function properly, ensure that the Spatial Analyst 
Extension is installed and activated.   

 
Now, open ArcMap and make sure that all of the NIFTT toolbars are visible as 
shown in figure 3-10: 
 

 

 

MRIT 
toolbar 

FRCC 
MappingTool 

toolbar 

Area Change 
Tool  toolbar 

 

FBAT 
toolbar 

 
Figure 3-10. ArcMap showing NIFTT toolbars. 
 
 

Note:  Toolbars may be “floating,” and you may need to anchor them in 
convenient locations by dragging them to toolbars at the top of your screen.  

 
 

3.1.2 Single tool (ACT) installation 

 
If you wish to install or reinstall ACT as a single tool without the entire NIFTT 
package, follow these steps: 

 
1. From the NIFTT website at www.niftt.gov, click on NIFTT Tools and 

User Documents in the menu. On that page, select NIFTT Tools.  
2. Click on the ACT Install file as shown in figure 3-11. 
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Figure 3-11. Downloading individual ACT tool. 
 
 
3. Navigate to the directory in which you have copied NIFTT tool files and 

downloaded ACT (see figs.3-4 and 3-5). 
 

4. If the installer determines a previous version of ACT is already installed, go 
to the Control Panel (Start > Settings > Control Panel) and select 
Add/Remove Programs.  Uninstall Area Change Tool and then rerun 
Setup.exe. 
 

5. If the installer determines that Microsoft Data Access Components (MDAC) 
are not up-to-date, run mdac_type.exe from the distribution source and 
rerun Setup.exe. 
 

6. If the installer determines the setup needs the .NET Framework, double 
click on the dotnetfx.exe file and follow the prompts.  When complete, 
double click Setup.exe to continue. 
 
Tip:  If the dotnetfx.exe file is already present on your computer, the 
downloaded .zip file will contain everything needed to install FBAT on your 
computer.  If it is not already installed, you must download and install 
dotnetfx.exe. 
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7. Once the installation begins, choose to install ACT for a single user (“Just 
Me”) and then select your install location.  Follow the defaults and then 
select Close. 
 

8. Open ArcMap with your desired map document.  Go to the View menu and 
select Toolbars.  Make sure that the ACT Toolbar is checked and visible.    

 
 
 

 
 

Figure 3-12. Selecting the ACT toolbar. 
 
 

Note:  Be sure that you do not have an earlier version of ACT installed on your 
computer before downloading any newer version of the product. 

 
 

3.2 Troubleshooting ACT installation 
 

If the ACT toolbar shown at the right   does not appear automatically when you 
open ArcMap, you will need to select View > Toolbars and check the box to the left 
of ACT Wizard 2.0.3 as shown in the figure below: 
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Figure 3-13. Verifying ACT toolbar is checked. 

 
 
If you are still unable to view the ACT toolbar, follow these steps: 
 
1. Click on the Tools menu and select Customize.  Make sure the ACT 2.0.3 and 

Spatial Analyst boxes are checked and select Close.  Next, click on the View menu 
and select Toolbars.  Be sure to check the box to the left of ACT 2.0.3 if it is not 
already checked. 
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Figure 3-14. The Customize dialog box. 

 
 
2. If you still cannot view the ACT toolbar in the ArcMap window, ACT may not be 

properly installed.   You may need to verify that there are no earlier versions of 
ACT present and if so, uninstall any previous versions.  Finally, reinstall the latest 
version and try the following: 

 
a. In ArcMap, again select the Tools menu and click on Customize to open 

the box shown above (fig. 3-14). 
 

ACT 2.0.3 should now be present in the Customize list as shown in the 
above figure.  It should be checked.  If it is not, check the box to the left of 
the file.   

 
b. In ArcMap, select the View menu and click on Toolbars.  Make sure that 

the Area Change Tool Toolbar 2.0.3 box is listed and checked and make sure 
that the Spatial Analyst Toolbar is installed and turned on.   

 
Tip:  Just because you can view a Spatial Analyst toolbar in ArcMap doesn’t necessarily 
mean that the tool is installed and operational.  You can verify that it is turned on by 
selecting Tools > Extensions. If Spatial Analyst is listed but not checked, check it 
now; if it is not listed, then you will need to obtain it now. 
 
Note:  If you have any additional questions about tool installation, please contact the 
helpdesk at: helpdesk@landfire.gov.  
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Chapter 4:  Using the ACT Interface 
 
 
4.1 The ACT interface 
4.2 Starting ACT 
4.3 Setting the editing task  
4.4 Uniform Change editing 
 4.4.1 GIS functions 

4.4.2 Create a new shapefile 
4.4.3 Edit an existing shapefile 
4.4.3.1 The Editor Toolbar 
4.4.4 Convert shapefile attributes to new rasters  
4.4.5 Merge edited rasters with original rasters 

4.5 Variable Change editing 
4.5.1 GIS functions 
4.5.2 Create a new shapefile 
4.5.3 Edit an existing shapefile 
4.5.4 Convert shapefile attributes to rasters 
4.5.5 Combine rasters 
4.5.6 Edit raster attribute table 
4.5.7 Convert raster attributes to rasters 
4.5.8 Merge edited rasters with original rasters 

 

 

4.1 The ACT interface 
 
ACT uses a Wizard interface to guide the user through a sequential process for 
delineating vegetation and fuel treatment polygons, combining raster data layers that 
need to be changed to reflect treatment objectives, editing the value attribute table to 
reflect the treatment outcomes, and creating new raster layers that depict treatment 
outcomes.  Although ACT uses a linear process to link multiple GIS processing steps 
together, that sequential process need not be followed or completed.  Instead, any of 
ACT’s GIS tasks can be selected in any order, or used completely independently of each 
other.   
 
ACT uses a suite of various user-friendly dialog boxes to complete GIS processing.  
Each dialog box includes an overview as well as tool tips to help the user navigate within 
the box itself (fig. 4-1). 
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Figure 4-1. Each dialog box contains Overview and Navigation tips. 

 
 

4.2 Starting ACT 
 
Because ACT operates from an ArcMap platform, ArcMap must be opened before ACT 
can be initiated.  A toolbar consisting of a single icon should be visible after you open an 
ArcMap project (fig. 4-2).  
 
 
 

24 



Area Change Tool User’s Guide   Chapter 4 

 
 

 
Figure 4-2. The ACT toolbar. 

 
 

1. First start ArcMap and create a new project by selecting A new empty map as 
shown in figure 4-3: 

 
 

 
 

Figure 4-3. Creating a new project in ArcMap. 
 
 

2. Next, load input layers into your ArcMap project by clicking on the Add Data 
icon (fig. 4.4): 
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Figure 4-4. Loading input layers. 
 
 
 

3. Navigate to the directory where your data layers are stored and add input 
layers. 

 
 

Tip:  At this point, you may see several Create pyramids dialog boxes similar to the box 
shown in figure 4-5.  Click No to speed up processing.   If you do not want to see this 
box again, put a check in the lower left-hand corner to disable it. 

 
 

 

Add Data 
icon 

 
Figure 4-5.  Create pyramids dialog box. 

 
 

4. Click on the ACT toolbar (fig. 4-2) to open the main dialog box (fig. 4-6).  All 
applications of ACT must begin with the Area Change Tool dialog box, which is 
used to specify the Editing Task, identify where to store outputs, and to select 
the GIS task that is to be performed.   
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Select the Editing 
Task 

Figure 4-6. Selecting the editing task. 
  
 

4.3 Setting the editing task  
 
Two types of editing can be accomplished using ACT.  The Uniform Change option will 
alter all raster values within a polygon to a single value that is specified by the user (in 
other words, a many-to-one change).  The Variable Change option allows you to change 
raster values within a polygon to many different values.  It represents a non-uniform 
change in which you can define rules that will include multiple changes to many 
attributes (or, a many-to-many change).  This option can also include changes to 
multiple data layers 
 
A Uniform Change might include creating a treatment area with a prescription that 
would change one or more grid values to a single value.  For example, a prescribed fire 
might change the fire behavior fuel model, canopy base height, and canopy cover so that 
each is represented by a single value (for example,  FBFM 2; 15-feet canopy base height, 
and 30 percent canopy cover).  All other values outside of the burn perimeter would 
remain unchanged.   
 
Uniform Change edits are generally useful only when dealing with very homogenous 
environments.  Typically, vegetation and fuel prescriptions vary according to the 
complexity of conditions on the land (slope, aspect, biophysical setting, cover type, size 
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class, canopy cover, surface fuels, canopy fuels) or according to management objectives 
(habitat objectives, visual objectives, air quality objectives).  The Variable Change editing 
process is more useful to real world GIS challenges. 
 
A Variable Change involves altering many different values within a polygon to many 
other values.  Typically, the different values are assigned on the basis of a combination of 
attributes denoting different conditions.  For example, since fire behavior varies with 
weather, fuels, and topography, it is not surprising that fuel treatment prescriptions 
might vary according to attributes such as slope, aspect, elevation, surface fuels, and 
canopy fuels. 
 
Select the radio button that corresponds to the type of editing that is desired (see fig. 4-
6 above).  We will first address the Uniform Change option. 
 

 
 

A Uniform Change 
allows you to change 
all pixels in an area to 

the same value. 
 

 
 

A Variable Change 
will allow you to 

change pixels within 
an area in a non-
uniform way to 
multiple values.

 

 

 

 

4.4 Uniform Change editing 
  
Remember that the objective of the Uniform Change is to change all of the current 
values of one or more layers that intersect a polygon to a single value. Follow the below 
steps to edit data using the Uniform Change option. 
 

Note:  If you would prefer to start with Variable Change editing, click on the link in this 
sentence to skip to that section. 

 
1. Select the Uniform Change radio button as shown above in figure 4-6. 

 
2. Identify a Project Name by entering the name of your choice in the window 

provided as shown in figure 4-7 below (this step is optional). 

3. Next select the Project Path by clicking on the browse icon  to navigate to a 
folder in which to store your output (this step is required).   

 
ACT will automatically fill in the “Project will be saved at” box if the user specified 
a name and a path for the project.  If a Project Name was not identified, then no 
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information will appear in this space.  There is no need for the user to enter any 
information.  
 
Tip:  Once a project path or location for the project to be stored is entered, it cannot be 
edited.  Therefore, if you make an error, you will need to start over with this dialog box. 

 
 

 

Enter the Project Name to 
identify a folder for storing 

outputs. 

Enter a path for storing the 
output folder. 

ACT will enter the complete 
path, including the project 

name. 

GIS Functions 
available with 

Uniform Change 

Figure 4-7. Providing inputs to the Area Change Tool dialog box. 

 
 

4.4.1 GIS functions 

 
There are four GIS functions that will be available for use when the Uniform 
Change option is selected.  These include:  

 
• Create a new shapefile – The shapefile is used to delineate polygons 

where edits are to occur.  When this option is selected, the Next button 
will take you to the New Shapefile interface. 

 
• Edit an existing shapefile – When this option is selected, the Next 

button will close ACT and bring up ESRI’s Editing Toolbar.  You can use the 
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Editor Toolbar to modify an existing shapefile.  When the edits are complete, 
once again select the main ACT dialog box to continue.   

 
• Convert shapefile attributes to rasters – When this option is selected, 

clicking on the Next button will take you to the Shapefile Attributes to New 
Rasters dialog box.  This utility allows you to convert any numerical attribute 
contained within the shapefile to a new raster layer. 

 
• Merge edited rasters with original rasters – When this utility is 

selected, the Next button will take you to the Merge Edited Rasters dialog 
box.  This function is used to “burn-in” the values from an edited layer into 
the original layer.  Thus, a new layer is created by adding the edited values to 
the original values. 

 
 

4.4.2 Create a new shapefile 

 
The process for creating a new shapefile occurs in essentially two steps.  The 
first step involves delineating the polygons.  The second step involves attributing 
the polygons drawn in the first step.   

 
1. First, select the radio button Create New Shapefile under the GIS 

Function box shown in figure 4-8. This feature allows you to create an empty 
shapefile having either default or user-defined attributes that can be used 
during the editing session.   
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Check the radio button 
Create New Shapefile 

Click Next to open the 
New Shapefile dialog 

box 

Figure 4-8. Using ACT to create a new shapefile. 

 
 

2. Click Next to open the New Shapefile dialog box as shown below (fig. 4-9).  
This dialog box is used to name the shapefile and identify any attributes the 
user wishes to include in the shapefile.  Attributes should be added to the 
shapefile if values in the original raster layer may be changed. 
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Enter a name for the 
shapefile 

Click Add New 
Attribute to add 
attributes to the 

shapefile 

Browse to a folder for 
storing the shapefile 

Enter attribute name 
and data format 

information 

Figure 4-9. The New Shapefile dialog box. 

 
 

3. Enter a name for your shapefile in the box above (fig. 4-9).  Remember that 
you do not need to add an extension, and the name is limited to eight 
characters or less.  In addition, the file name you select should not contain 
any spaces, leading numbers, or special characters (such as `~! @#$^()-+={ 
}[ ]|\?/:;”’< >,.). 

   
 

You can add any attribute to the shapefile by clicking Add New Attribute and 
entering a Name, Data Type, Length, and Precision (the number of decimal 
places).  If the shapefile will contain multiple polygons, we recommend that you 
include an identifier as an attribute to keep track of the specific polygons.  
Notice that ACT can add default attributes to the shapefile, if desired.  Simply 
check the box indicating Uniform Change - Default Attributes.  The default 
attributes were established for those interested in editing surface and canopy 
fuel layers and succession class layers, which are used to derive fire regime 
condition class (fig. 4-10).  The default attributes are shown in table 4-1. 
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Table 4-1. Default attributes available for the Uniform Change option. 

Attribute Name Attribute Description 
Id Polygon identifier 
SClass Succession class 
FBFM Fire behavior fuel model 
CC Canopy cover 
CH Canopy height 
CBH Canopy base height 
CBD Canopy bulk density 

 
 

 

Uniform Change 
default fields 

Figure 4-10. Selecting the default attributes for a Uniform Change. 
Only attributes that have been checked will be added to the 
shapefile. 

 
 

4. Check the box to the left of Attribute Name after adding all attributes that 
you are interested in editing.  Only those attributes that have been checked 
will be included within the shapefile.  Simply check or uncheck selections to 
add or remove them from your new shapefile.   

 
Tip:  Using the Data Type drop-down menu allows you to choose a data type such 
as “Long Integer,” “String,” etc., or you can accept the default values.  The Length 
field gives the expected number of characters in a string.  The ACT Tool Tip defines 
the Precision field as “the number of digits in a number.”  You can modify the data 
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format as needed.  Refer to ArcGIS Desktop Help for further information pertaining 
to data type. 

 
5. Click Next when the dialog box is complete to open the Editor Toolbar and 

close ACT.    
 
 

4.4.3 Edit an existing shapefile 

 
1. Select the Edit Existing Shapefile radio button in the GIS Function box if you 

want to edit an existing shapefile rather than create a new shapefile from 
scratch (fig. 4-11).  

 
 

 

Select 
Edit Existing 

Shapefile 

Figure 4-11. Selecting the Edit Existing Shapefile GIS function 
from the Area Change Tool dialog box. 

 
 

2. Click Next to open the Editor toolbar. The Editor toolbar used by ACT (fig. 
4-12) is exactly the same as the Editor toolbar available in ArcMap.  The 
Editor Toolbar is used to create and/or edit shapefiles.    
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Figure 4-12. Editor toolbar and Editor drop-down menu. 

 
 

Tip:  When editing is complete, return to the ACT Wizard Interface by clicking on 
the ACT toolbar. 

 
3. Click on the Editor drop-down menu and click on Start Editing at the top 

of the list as shown in figure 4-12. 
 

4. When the Start Editing dialog box appears (fig. 4-13), select the appropriate 
path containing the shapefile to be edited.   
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Figure 4-13. The Start Editing dialog box indicating layers available for 
editing within the selected path. 

 
 

5. The Editor toolbar shown below will appear after you select the appropriate 
path.   Identify the editing task on the Editor Toolbar by selecting Create 
New Feature from the Task drop-down menu and then select the 
appropriate shapefile from the Target drop-down menu (fig. 4-14).    

 

 
 
 

 

Sketch Tool 
Task Target 

Figure 4-14. Editor toolbar showing the Sketch Tool, Task, and Target drop-down menus with the 
shapefile “TreatmentA” selected. 

 
 

6. Click on the Sketch Tool icon to begin drawing a polygon.  Consult ArcMap’s 
Help utility for more information on creating and editing polygons.  We 
recommend that you save your edits frequently (for example, after you have 
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completed each polygon).  When you have finished drawing all polygons 
within your shapefile, be sure to select Save Edits. 

 
Tip:  If you happen to make a mistake in your drawing, it may be easier to delete 
the polygon and start over rather than trying to edit an existing polygon. 

 
7. Next, you need to provide the appropriate values for the attributes within 

the shapefile.  Open the attribute table of the shapefile you have created by 
right clicking on the new shapefile in ArcMap’s Table of Contents and select 
Open Attribute Table (see fig. 4-15). 

 
 

 
Figure 4-15. Example attribute table of a shapefile with four polygons containing the following 
attributes: Id = polygon identifier, SClass = succession class, FBFM = fire behavior fuel model, 
CC = canopy cover, CH = canopy height, CBH = canopy base height, and CBD = canopy bulk 
density. 

 
 

8. Enter the values that you wish to use in the appropriate cells of your 
attribute table.  When finished, save your edits by selecting Editor > Stop 
Editing > Save Edits.  Close the Editor toolbar and the attribute table. 

 
Tip:  Be sure to press the Enter key after adding the last value and then close the 
attribute table before continuing. 

 
9. Select the appropriate Task and Target from the drop-down menus on the 

Editor toolbar (fig. 4-16).  Select the task Create New Feature if your 
objective is to add polygons.  Select the task Reshape Feature if your 
objective is to change the shape of existing polygons.  On the other hand, if 
your objective is to modify the values in the attribute table, simply open the 
attribute table and change the values. 

 
 

 
Figure 4-16. Identifying the task and target on the Editor Toolbar. 
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10. When finished editing, select Editor > Stop Editing > Save Edits. 
 
 

4.4.4 Convert shapefile attributes to rasters 

 

The next step in the Uniform Change process is to convert a shapefile’s 
attributes of interest to new raster layers.  The GIS function Convert Shapefile 
Attributes to Rasters enables the user to convert every attribute of a shapefile 
to a new raster layer.  

  
1. Select the radio button to the left of Convert Shapefile Attributes to 

Rasters and click Next (fig. 4-17). 
 
 

 

Select Convert Shapefile 
Attributes to Rasters 

Click Next to open a dialog 
box for converting 

shapefile attributes to 
raster layers 

Figure 4-17. Selecting Convert Shapefile Attributes to Rasters function. 

 
 
 

2. Click Next to open the following dialog box (fig. 4-18): 
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Enter a name for the 
new raster 

 Check the box of 
the Shapefile 

Attributes 

Identify the shapefile 
containing the attributes 
that you wish to convert 

to raster layers. 

Figure 4-18. Shapefile Attributes to New Rasters dialog box.  In this 
example, the shapefile contains seven attributes: Id = polygon 
identifier, SClass = succession class, FBFM = fire behavior fuel 
model, CC = canopy cover, CH = canopy height, CBH = canopy 
base height, and CBD = canopy bulk density. 

 

 
Note: The target shapefile must exist within the ArcMap Table of Contents before 
you can convert its attributes to new rasters. 

 
3. Select the appropriate shapefile containing the attributes to be converted to 

rasters from the drop-down menu at the top of the dialog box (fig. 4-18).  
Provide a name for each new raster by double clicking the space under New 
Raster Name and then enter a name.  Once you have entered a new raster 
name, the box to the left of each attribute’s name will become enabled, and 
you can check the attributes that you would like to convert.  Only attributes 
that are checked will be converted to a new raster. 

 
Note:  Remember that you do not need to add an extension, and the name is 
limited to eight characters or less.  In addition, the file name you select should not 
contain any spaces, leading numbers, or special characters (such as `~! @#$^()-
+={ }[ ]|\?/:;”’< >,.). 
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Tip:  You will not be able to check the boxes under the Shapefile Attributes window 
until you double-click in the corresponding New Raster Name cell and enter a 
name. 

 
4. When you have finished filling out the dialog box, use the browse button to 

select a path and folder for storing the new rasters.  Click Next to begin the 
conversion process.  The new raster layers will automatically be added to the 
ArcMapTable of Contents.  

 
Note: A progress bar located at the bottom of the dialog box indicates that 
conversion is proceeding.    

 

 

4.4.5 Merge edited rasters with original rasters 

 
The last step in the Uniform Change process is to merge the newly created 
rasters into the original, or target, rasters, thereby creating a new raster that 
covers the full extent and that reflects the edits that have been made.  

 
1. First make sure that the Edited Rasters and Target Rasters are available in 

your ArcMap project.  The availability of rasters that can be selected from 
the Merge Change Raster dialog box depends on the layers existing within 
the Table of Contents of your ArcMap project.   

 
2. Next, select the radio button pertaining to Merge Edited Rasters with 

Original Rasters as shown in figure 4-19 to merge the Edited and Target 
rasters.  Click Next to open the following Merge Change Rasters dialog box: 
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Select radio button to 
merge rasters together 

Figure 4-19. Selecting the Merge Edited Rasters with Original 
Rasters function from the Area Change Tool dialog box. 
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Figure 4-20. The Merge Change Rasters dialog box is used to identify the 
rasters and attributes that will be merged together. 

 

 
The Merge Change Rasters dialog box (fig. 4-20) requires the following 
information. 

 
• Edited Raster – The raster created from the shapefile containing 

the edited information.  The list of available rasters includes any 
raster currently in the ArcMap Table of Contents.  The Edited Raster 
will be merged into the original or target raster.  

• Edited Raster Attribute – The attribute contained within the 
Edited Raster that will be used to overwrite the corresponding 
attribute from the original or target raster. The drop-down menu will 
include all attributes contained within the Edited Raster. 

• Target Raster – The original or target raster that will be merged 
with the Edited Raster.  The drop-down menu will include any raster 
that currently resides in the ArcMap Table of Contents. 

• Target Raster Attribute – The attribute from the target raster 
that will be overwritten by the attribute from the Edited Raster. 

• Merged Raster Name – The new raster created by merging the 
edited and original rasters together. 
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3. First, highlight the row containing an edited raster that you wish to use to 
overwrite an existing raster.  Use the Enter key to advance your cursor to 
the next column labeled Edited Raster Attribute.  Double-click in the cell to 
activate the drop-down menu.  The drop-down menu will list all attributes 
contained within the Edited Raster.   

 
4. Next select the appropriate attribute and use the Enter key to advance the 

cursor to the next column (Target Raster).  Select the target raster from a 
drop-down menu that includes every raster within the ArcMap Table of 
Contents.   Again, use the Enter key to advance your cursor to the next 
column (Target Raster Attribute).  Select the attribute of the target raster 
that will be overwritten by the Edited Raster.  Use the Enter key to advance 
your cursor to the last column (Merged Raster Name) of the dialog box.   

 
5. Enter a name for the new raster that will result from merging the Edited 

Raster with the Target Raster.  Lastly, place a check in the box associated 
with the Edited Raster in the first column.   

 
Note:  Remember that you do not need to add an extension, and the name is 
limited to eight characters or less.  In addition, the file name you select should not 
contain any spaces, leading numbers, or special characters (such as `~! @#$^()-
+={ }[ ]|\?/:;”’< >,.). 

 
Use the Browse icon located to the right of the “Save Rasters to:” window 
to navigate to an appropriate folder for storing the newly created rasters. 

 
6. Click Finish to initiate the processing of the new raster layers which will 

automatically be added to the ArcMap Table of Contents.  The “Uniform 
Change” process is now complete. 

 
Tip:  Rest your cursor on the Navigation button located at the upper right corner of 
the dialog box for help in moving around the Merge Change Rasters dialog box. 

 

Be sure to follow the 
usual naming 

conventions used with 
ACT.

 
 
 
 

 
 

4.5 Variable Change editing 
 
The Variable Change editing process involves changing pixel values in a non-uniform 
manner.  Frequently, the edits are made within polygons that denote a target area.  
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However, these changes can also be made across the full extent of the data layer(s) 
without the use of polygons.  
 
Note: the instructions in this section are very similar to those for the above section on editing 
using the Uniform Change option. Rather than referring the reader back, we repeat the 
instructions here for convenience.  
 
1. Start the editing process by opening ArcMap, adding all layers of interest, and then 

clicking on the ACT Toolbar -  
 
2. The Area Change Tool dialog box will open (fig. 4-21).  Select the radio button 

below Editing Task to the left of Variable Change.   
 
3. Enter a Project Name (optional) and Project Path as demonstrated in figure 4-7.  

The project name will establish a unique folder for storing all outputs; leave this 
entry empty if a unique output folder is not desired.   
 

 

4.5.1 GIS functions 

 
There are seven GIS functions that will be available for use when the Variable 
Change option is selected.  These include:  

 
• Create a new shapefile – The shapefile is used to delineate polygons 

where edits are to occur.  When this option is selected, the Next button 
will take you to the New Shapefile interface. 

 
• Edit an existing shapefile – When this option is selected, the Next 

button will close ACT and bring up ESRI’s Editing Toolbar.  You can use the 
Editor Toolbar to modify an existing shapefile.  When the edits are complete, 
once again select the main ACT dialog box to continue.   

 
• Convert shapefile attributes to rasters – When this option is selected, 

clicking on the Next button will take you to the Shapefile Attributes to New 
Rasters dialog box.  This utility allows you to convert any numerical attribute 
contained within the shapefile to a new raster layer. 

 
• Combine rasters – This function is used to integrate multiple data layers 

by selecting attributes from rasters to join into a combine raster. Clicking on 
the Next button opens the Combine Rasters interface. 

 
• Edit the raster attribute table – When this option is selected, clicking on 

the Next button opens the Edit Rasters Manager.  This dialog box can be 
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used to transfer an attribute table to Excel, transfer edited data in Excel to 
an attribute table, transfer an attribute table to Access, or to transfer edited 
data in Access to an attribute table. 

 
• Convert raster attributes to rasters – This option allows you to create 

individual raster layers from the attributes of a combined layer.  Clicking on 
the Next button will open the Raster Attributes to Rasters dialog box. 

 
• Merge edited rasters with original rasters – When this utility is 

selected, the Next button will take you to the Merge Edited Rasters dialog 
box.  This function is used to “burn-in” the values from an edited layer into 
the original layer.  Thus, a new layer is created by adding the edited values to 
the original values. 

 
 

Although the ACT Wizard toolbar was designed to follow a sequence of 
processing steps, a user does not have to follow the sequence or complete all of 
the steps.  In other words, each of the GIS functions can be used independently 
as a stand-alone process.  For example, if you plan to make changes throughout 
the entire extent of your analysis area, there is probably no need to create a 
shapefile to constrain the changes to a limited area.  In this instance, the editing 
process might actually begin with combining a suite of rasters. 
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Enter a Project Name, 
and identify a path for 

storing outputs 

GIS functions 
available with the 
Variable Change 

process 

Select the Variable 
Change radio button 

Figure 4-21. Area Change Tool dialog box showing the GIS 
functions available when conducting Variable Change edits. 

 
 

4.5.2 Create a new shapefile 

 
The process for creating a new shapefile occurs in essentially two parts.  The 
first part involves delineating the polygons.  The second part involves attributing 
the polygons drawn in the first part of the process.   

 
1. First, select the radio button Create New Shapefile under the GIS 

Function box shown in figure 4-22. This feature allows you to create an 
empty shapefile having either default or user-defined attributes that can 
be used during the editing session.   

 
2. Click Next to open the New Shapefile dialog box as shown in figure 4-

23.  This dialog box is used to name the shapefile and to identify any 
attributes you wish to include.  Attributes should be added to the 
shapefile if you intend to change their values in the original raster layer. 
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Check the radio button 
Create New Shapefile 

Click Next to open 
the New Shapefile 

dialog box 

Figure 4-22. Using the ACT Wizard to create a new shapefile. 

 
 

3. Enter a name for your shapefile (fig. 4-23). Remember that you do not 
need to add an extension, and the name is limited to eight characters or 
less.  In addition, the file name you select should not contain any spaces, 
leading numbers, or special characters (such as `~! @#$^()-+={ }[ 
]|\?/:;”’< >,.). 
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Enter a name for the 
shapefile 

Figure 4-23. Creating a new shapefile. 

 
 
You can add any attribute to the shapefile by clicking Add New Attribute.  
You will need to provide an Attribute Name, Data Type, Length, and 
Precision (number of decimal places).  If the shapefile contains multiple 
polygons, we recommend that you include an identifier as an attribute to 
keep track of the specific polygons.  Checking the box next to Variable 
Change - Default Attributes adds an identifier for individual polygons (fig. 4-
24). 

 
 
 

Browse to a folder 
for storing the 

shapefile 

Enter attribute name 
and data format 

information 

Click Add New 
Attribute to add 
attributes to the 

shapefile 
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Variable Change 
default attributes 

Figure 4-24. Selecting default attributes for Variable Change.   

 
 

Be sure to check the box to the left of the “Attribute Name” after adding all 
attributes that you are interested in editing.  Only those attributes that have 
been checked will be included in the shapefile.  Simply check or uncheck 
selections to add or remove them.   

 
Tip:  Using the Data Type drop-down menu allows you to choose a data type such 
as “Long Integer,” “String,” etc. (or you can accept the default values).  The Length 
field gives the expected number of characters in a string.  The ACT Wizard’s Tool 
Tip defines the Precision field as “the number of digits in a number.”  You can 
modify the data format as needed.  Refer to ArcGIS Desktop Help for further 
information pertaining to data type. 

 
4. Click Next when the dialog box is complete to open the Editor toolbar 

and close ACT.    
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4.5.3 Edit an existing shapefile 

 
1. Select the Edit Existing Shapefile radio button under GIS Function (fig. 4-

25) if you want to edit an existing shapefile rather than create a new shapefile 
from scratch.   

 

 

Select the  
Edit Existing 

Shapefile radio 
button 

Figure 4-25. Use the Edit Existing Shapefile option to edit existing 
shapefiles. 

 
 

2. Click on Next to open the Editor toolbar (fig. 4-26), which you can use to 
add new polygons or to modify the shape of existing polygons.  In addition, 
select this option if you need to edit the values of an exiting shapefile’s 
attribute table.   The Editor toolbar used by ACT is exactly the same as the 
Editor toolbar available in ArcMap.    

 
 

 
Figure 4-26. The Editor Toolbar. 
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To start editing click on 
Editor and select Start 
Editing from the drop-

down menu 

Figure 4-27. Drop-down 
Editor menu. 

 
 

3. Click on the Editor drop-down list and select Start Editing at the top of 
the menu as shown above in figure 4-27.  As before, you will need to identify 
the path that contains the target shapefile.  A Start Editing dialog box, which 
is used to select the appropriate path containing the shapefile to be edited, 
will appear (fig. 4-28).   
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Figure 4-28. The Start Editing dialog box shows the layers available for 
editing within the selected path. 

 

 
4. After identifying the appropriate path, select an editing task from the Task 

drop-down menu on the Editor toolbar (fig. 4-29).   
 
 

 
 
 
Figure 4-29.  Selecting an editing Task from the Editor Toolbar. 
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5. Select Create New Feature if your objective is to add polygons.  Select 
Reshape Feature if your objective is to change the shape of existing 
polygons.  If your objective is to modify values in the attribute table, simply 
open the attribute table and change the values. 

 
6. Finally, you will need to select the appropriate shapefile from the Target 

drop-down menu on the Editor Toolbar (fig. 4-30). 
 
 

 
 
Figure 4-30. Use the Target drop-down menu on the Editor toolbar to select an appropriate 
shapefile. 
 

 
7. Select the Sketch Tool icon shown below (fig. 4-31) to begin drawing a 

polygon.  Consult ArcMap’s Help utility to learn more about creating and 
editing polygons.  We recommend that you Save Edits frequently (for 
example, after completing each polygon).  When you have finished editing, 
select Editor > Stop Editing > Save Edits. 

 
 

 
 

 

Target Task 

Select the 
shapefile to 
be edited 

Sketch Tool 

 
Figure 4-31. Editor toolbar showing the Sketch Tool, Task (Create New Feature), and Target 
shapefile (“TreatmentC”). 
 

 
Tip:  If you happen to make a mistake in your drawing, it may be easier to delete 
the polygon and start over rather than trying to edit an existing polygon. 

 
8. Now you will need to provide the appropriate values for the attributes 

within the shapefile.  Open the attribute table of the shapefile you have 
created by right clicking on the new shapefile in the ArcMap Table of 
Contents (fig. 4-32) and select Open Attribute Table. 
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Figure 4-32. Example attribute table of a shapefile with four polygons and containing the 
following attributes: Id = polygon identifier, SClass = succession class, FBFM = fire behavior fuel 
model, CC = canopy cover, CH = canopy height, CBH = canopy base height, and CBD = canopy 
bulk density. 
 

 
9. Enter the values that you wish to use in the appropriate cells of the attribute 

table.   
 

Note:  Be sure to press the Enter key on your keyboard after adding the last value 
and then close the attribute table before continuing. 

 
10. When you are finished, save your edits by selecting Editor > Stop Editing 

> Save Edits.  Close the Editor toolbar and the attribute table. 
 

Tip:  When you have finished editing, return to ACT by clicking on the ACT toolbar. 
 

 
 

4.5.4 Convert shapefile attributes to rasters 

 
The next step in the Variable Change process is to convert the attributes of 
interest in a shapefile to new raster layers.  The GIS function Convert Shapefile 
Attributes to Rasters enables the user to convert each attribute of a shapefile to 
a new raster layer.  Select the radio button to the left of Convert Shapefile 
Attributes to Rasters and click Next (fig. 4-33). 

 
 

54 



Area Change Tool User’s Guide   Chapter 4 

 

Select the radio button 
for converting shapefile 

attributes to rasters. 

Figure 4-33. Converting shapefile attributes to rasters. 

 
 

1. Click Next to open the following dialog box (fig. 4-34): 
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3) Check the box 
associated with the 
shapefile attribute to 

be converted

2) Enter a name 
for the new raster. 

1) Identify the 
shapefile containing 
the attributes to be 

converted to a raster 
layer. 

 
Figure 4-34. Shapefile Attributes to New Rasters dialog box.  In 
this example, the shapefile contains seven attributes: Id = polygon 
identifier, SClass = succession class, FBFM = fire behavior fuel 
model, CC = canopy cover, and CH = canopy height, CBH = 
canopy base height, and CBD = canopy bulk density. 

 
 

Tip: The target shapefile must exist within ArcMap’s Table of Contents before 
you can convert its attributes to new rasters. 

 
2. Select the appropriate shapefile containing the attributes to be converted 

to rasters from the drop-down menu at the top of the dialog box (fig. 4-
34 above).  Provide a name for each new raster by double clicking the 
space under New Raster Name and enter a name.  Once you have 
entered a new raster name, the box to the left of each attribute’s name 
will be enabled. You can then check the attributes that you would like to 
convert.  Only attributes that are checked will be converted to a new 
raster. 

 
Note:  Remember that you do not need to add an extension, and the 
name is limited to eight characters or less.  In addition, the file name you 
select should not contain any spaces, leading numbers, or special 
characters (such as `~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 
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Tip:  You will not be able to check the boxes under the Shapefile Attributes 
window until you double-click in the New Raster Name column and enter a 
name. 

 
3. When you have finished filling out the dialog box, use the browse button 

to identify the path and folder for storing the new rasters.  Click Next to 
begin the conversion process.  The new raster layers will automatically 
be added to the ArcMap Table of Contents.  

 
Note: A progress bar located at the bottom of the dialog box indicates that 
conversion is proceeding.    

 
 

4.5.5 Combine rasters 

 
Combining rasters is an effective technique for integrating multiple data layers at 
the pixel level.  When rasters are combined, each cell of the combined raster is 
assigned to one of the unique combination of cell values from the input layers. 
The cell values of the input layers become attributes of the combined layer (see 
the ArcGIS help utility for a more thorough explanation of combining raster 
layers).  
 
The maximum number of grids that can be input into the ArcGIS “combine” 
function varies with different hardware platforms.  The combine function is also 
limited by the range of grid values in each layer.  No more than 10 million unique 
combinations are possible.  However, ArcGIS currently determines the number 
of potential combinations based on the maximum grid values in each of the 
layers to be combined.  For example, if a layer has two unique values with grid 
values of 100 and 101, then ArcGIS assumes that there are actually 101 unique 
values in that layer.  If this layer is combined with a similar layer, ArcGIS assumes 
that the combine function will result in 10,201 potential values even though in 
reality, there could be only four potential values representing the unique 
combinations of both layers. 

 
Tip:  If you receive an error message indicating that the combine function will 
result in over 10 million unique combinations, you may be able to remedy the 
situation by: 

• dropping one or more of the input layers, 
• reclassifying the values of the input layers to decrease their 

maximum values, 
• classifying the values of the input layers to reduce the number 

of potential combinations, or 
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• combining the layers in stages.  For example, combine the first 
three layers in one step, the second three layers in another 
step, and then lastly combine the two combined layers.  

  
Note:  The remainder of this chapter will use a single example to 
demonstrate the Variable Change editing process.  This example involves 
updating five fuel layers using the burn severity layer of a recent fire.  
Specifically, fuel layers characterizing pre-burn conditions will be updated 
using the Variable Change editing process to reflect post-burn conditions.   

 
 

All input layers to be combined must be added to your ArcMap project prior to 
initiating the combine function.  After adding all layers of interest to ArcMap, 
select the radio button to the left of Combine Rasters (fig. 4-35) to open the 
Combine Rasters dialog box. 

 
 

 

Select the radio 
button to combine 

rasters 

Figure 4-35. Selecting the Combine Rasters function. 

 
 

The Combine Rasters dialog box (fig. 4-36) is used to name the new combined 
layer, order the layers as they will appear in the value attribute table, and identify 
additional attributes from the input layers that should be included within the 
value attribute table of the combined layer.   
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1. First, provide a name for the combine raster in the window labeled New 

Raster Name.  
 

Note:  Remember that you do not need to add an extension, and the name is 
limited to eight characters or less.  In addition, the file name you select should 
not contain any spaces, leading numbers, or special characters (such as `~! 
@#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
2. Next, identify the rasters layers that are to be combined.  The Rasters to 

Combine column will include any rasters that have been loaded into your 
ArcMap project.  Place a check in the box associated with any raster to 
be included in the combined layer.  The order in which rasters are 
checked will determine how they are arranged in the value attribute table 
of the combined layer.  The column labeled Attrib Order will 
automatically display the sequence in which layers are checked.   The last 
column in the dialog box, Join Attributes, adds any ancillary attributes, 
such as descriptive labels of a layer, into the value attribute table of the 
combined layer.  To include an ancillary attribute, double-click on the 
appropriate cell and then check the box or boxes of those attributes to 
be included. 

 
 

 

Enter a name for the 
combined layer 

Check the layers to be 
combined.  The sequence 

in which layers are 
checked will determine 
their order within the 

attribute table.  Identify 
any ancillary attributes that 
should be included within 

the attribute table 

Figure 4-36. The Combine Rasters dialog box. 

59 



Area Change Tool User’s Guide   Chapter 4 

 
 

3. When you have completed the dialog box by identifying the rasters 
(Rasters to Combine), specifying their appropriate order (Attrib Order), 
and adding important ancillary attributes (Join Attributes), use the browse 
icon to navigate to the folder in which you wish to use to store the 
combined layer.  You can accept the default path or choose a new 
location.   
 

Click Next to create the new raster.   The new raster will automatically be added 
to the Table of Contents in your ArcMap project.  Review the value attribute table 
of the combined layer to ensure that the layer will meet your needs.  The value 
attribute table for this example is displayed below (fig. 4-37).  
 
 
 
 
 

 

Attributes of input rasters Values of input rasters 

Figure 4-37. The attribute table of the combined layer showing the first 11 of 2,491 records. 

 
 

4.5.6 Edit raster attribute table 

 
ACT has two options for editing attribute tables of raster layers:  Microsoft 
Excel or Microsoft Access.  The choice of software program is largely dependent 
on your own experience.  Excel may be easier to use, but can be more tedious 
than Access and can be inappropriate for large editing projects.  Attribute tables 
of a combined layer commonly contain thousands of records which may prove 
problematic when using Excel since Excel has a limit of 65,560 records.   Using 
Access is typically more efficient since update queries can change hundreds of 
records simultaneously.   
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Select the Edit Raster Attribute Table radio button in the Area Change Tool 
dialog box (fig. 4-38) and click Next to open up the Edit Raster Manager dialog 
box (fig. 4-39). 
 
 

 

Select the Edit 
Raster  Attribute 

Table radio button 

Figure 4-38. Selecting the GIS function to edit a raster attribute table. 
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Export a raster 
attribute to Excel 

Import an edited 
raster attribute 

table from Excel 

Export a raster 
attribute table 

to Access 

Import an edited 
raster attribute 

table from Access 

 
Figure 4-39. The Edit Rasters Manager dialog box. 

 
 

The Edit Rasters Manager dialog box (fig. 4-39) is used to transfer value attribute 
tables to either Excel or Access for editing and subsequently to transfer the 
edited Excel/Access data to a value attribute table of a new raster layer.  The 
upper portion of the Edit Rasters Manager dialog box pertains to Excel and the 
bottom half relates to Access.   

 
 

Excel Transfer 
 
Part 1:  Transfer an attribute table to Excel  

 
Three steps are required to export an attribute table to an Excel spreadsheet for 
editing (fig. 4-40).   
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1. First, identify the raster that is to be edited by clicking on the browse 

icon to the right of the Raster box.   
 

2. Second, create an Excel spreadsheet by clicking on the folder icon to the 
right of the box labeled New Excel File. 

 
3. Lastly, export the raster attribute table to Excel by clicking the large icon 

(Export a raster attribute table to Excel) to the right of the Excel 
Transfer Part 1 box.  During the exporting process, the record count of 
the raster will appear in the dialog box.  This feature is useful for 
determining if the raster has more than 65,560 records which will exceed 
the capacity of Excel spreadsheets.  Excel will open automatically when 
the exporting process is complete (fig. 4-41).  

 
Tip:  If the record count exceeds the limit of Excel (65,560 records), a warning 
message will appear on your screen and the Excel transfer will stop. 

 
Note: A progress bar at the bottom of the dialog box indicates that the 
transfer is proceeding. Processing may take several minutes for rasters with 
large numbers of records and/or attributes.  
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1)  Identify the raster 
to be edited 

2)  Name the Excel 
file to be created 

3)  Export data to 
Excel 

Figure 4-40. Use the Edit Rasters Manager dialog box to export 
a raster attribute table to Excel. 

 
 

 
Figure 4-41. An Excel spreadsheet derived from the value attribute table. 
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You can begin editing immediately after Excel opens.  However, please note the 
following editing caveats: 
 

• We recommend making a backup copy of the spreadsheet prior to 
changing any values.  If mistakes are made, an original copy will be 
available to fall back on. 

• Never change values in the ObjectID, Value, or Count fields of a 
combined raster.  Instead, edit only the attributes of that raster. 

• Never delete any records. 
• Be very careful when sorting a spreadsheet – data can easily be 

scrambled beyond repair.  Be sure to sort the entire spreadsheet and 
not just some subset of fields.  Always return the spreadsheet to its 
original form before transferring data to an attribute table by sorting 
the entire spreadsheet using the Value field. 

 
Use the SaveAs function to save your worksheet when edits are complete.  
Close Excel and save your ArcMap project at this point. 

 
 

Part 2:  Transfer edited data in Excel to an attribute table 
 

This feature of ACT is used to create a new raster from the edited version of an 
Excel worksheet.  Open the Area Change Tool dialog box and then select the 
radio button Edit Raster Attribute Table.  The following steps are required to 
import a spreadsheet into an attribute table (see fig. 4-42 below). 

 
1. Identify the Excel spreadsheet that contains the edited data by clicking on 

the browse button to the right of the Excel file box.   
 

2. Identify the Original Raster that was used to create the Excel 
spreadsheet.  ACT will commonly provide this information automatically, 
but make sure that this information is correct before you continue. 

 
3. Enter a name and path for the New Raster by clicking on the browse 

button to the right of the New Raster box.  Remember that the name is 
limited to eight characters or less.  In addition, the file name you select 
should not contain any spaces, leading numbers, or special characters 
(such as `~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
4. Create the new raster by clicking on the large icon (Import an edited 

attribute table in Excel) at the far right of the Part 2 box.   
 
 

The new raster will be added automatically to the Table of Contents in your 
ArcMap project.  Save your ArcMap project at this time. 
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1) Identify the Excel 
file containing the 

edited data 

2) Identify the original 
raster used to create 

the Excel file 

4) Create a new 
raster

3) Enter a name 
for the new raster 

 
Figure 4-42. Use the Edit Rasters Manager dialog box to create 
a new raster from an edited Excel spreadsheet. 

 
 

Access Transfer 
 

Part 1:  Transfer an attribute table to Access 
 

Open the Edit Rasters Manager dialog box by selecting the radio button labeled 
Edit Raster Attribute Table.  The bottom portion of the Edit Rasters 
Manager dialog box pertains to using Access to edit the attribute table of an 
existing raster. 
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Exporting a value attribute table to Access is a simple three-step process (see fig. 
4-43 below). 

 
1. Identify the raster to be edited by clicking on the browse button to the 

right of the Raster box.   
 

2. Name the Access database by clicking on the browse button to the right 
of the New Access DB window. 

 
3. Click on the large icon to the far right of the Access Transfer Part 1 box 

to export the value attribute table into an Access database.  The Access 
database will open automatically when the transfer process is complete.  
The database will contain a table with the same name as the database (fig. 
4-44).  Open the table and begin editing. 
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3)  Export the Value 
Attribute Table to 

Access 

2)  Identify the name and 
path for the Access 

database 

1)  Identify the raster 
to be edited 

Figure 4-43. Use the Edit Rasters Manager dialog box to transfer 
a value attribute table to an Access database. 

 
 

 
Figure 4-44. An Access table derived from the value attribute table. 
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Tips:   
• It is always a good idea to create a backup table before any changes are 

made.  The backup table can be quite useful if mistakes are made during 
editing that cannot be easily corrected. 

• Never change values within the OBJECTID, VALUE, or COUNT attributes of 
a combined raster.  Change data only in fields corresponding to layer 
attributes. 

• Never delete any records. 
• Save any update queries used for editing.  These queries can be useful at a 

later date for identifying errors.  In addition, queries document changes that 
you have made and can be used in another editing process to make 
consistent changes.  

 
 

Part 2:  Transfer edited data from Access to a value attribute table 
 

This feature is used to create a new raster from the edited version of an Access 
database table.  Open the Area Change Tool dialog box and then select the 
radio button labeled Edit Raster Attribute Table to open the Edit Rasters 
Manager dialog box.  The following steps are required to import a database into 
an attribute table (see fig. 4-45 below). 

 
1. Select the Access database that contains the table to be converted to an 

attribute table.  Click the browse button to the right of the Access DB box 
to navigate to your database.    

 
2. Select the appropriate table in the database by using the drop-down menu to 

the right of the Access Table window. 
 

3. If necessary, identify the original raster layer using the browse button 
associated with Original Raster.   ACT will usually complete this step 
automatically once the Access table is identified.  However, make sure that 
the Wizard has identified the correct raster layer before proceeding. 

 
4. Identify a name and path for the new raster layer by clicking on the browse 

button to the right of the New Raster window.   Remember that the name is 
limited to eight characters or less.  In addition, the file name you select 
should not contain any spaces, leading numbers, or special characters (such 
as `~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
5. Create the new raster by clicking on the icon Import an edited raster 

attribute table from Access to the right of the dialog box.  The new raster 
containing the edited information will appear automatically in the ArcMap 
Table of Contents. 
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5)  Create the new 
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Figure 4-45. Converting Access database table to a new raster layer. 

 
 

From the drop-down menu to the right of Access Table, select the table to 
import from Access.  If the original raster is located, its path and name will be 
displayed in the box to the right of Original Raster.  However, if it is not found, 
the icon to the right of the box will be enabled, and you will need to click on it 
to browse to the original raster.  Once a valid original raster has been entered, 
the folder to the right of New Raster will be enabled.  Click on this icon and 
enter a name and path for your new raster.  Next, click on the icon “Import an 
edited raster attribute table from Access” located to the right of the box as 
shown above in figure 4-45.  The new raster layer will be created and added to 
your ArcMap project’s Table of Contents.    
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4.5.7 Convert raster attributes to new rasters  

 
This feature of ACT is used to create individual raster layers from the attributes 
of a combined layer.  Open the Area Change Tool dialog box and select the 
radio button for Convert Raster Attributes to Rasters (fig. 4-46).   
 

Tip:  The raster of interest must exist within your ArcMap project before this 
GIS function can be implemented.  

 

 

Select radio button 
to convert Raster 

Attributes to Rasters 

Figure 4-46. Converting raster attributes to raster layers. 

 
 

A dialog box entitled Raster Attributes to Rasters will open (fig.4-47). 
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Identify the raster layer 
containing the 
attributes to be 

converted into new 
raster layers 

Figure 4-47. The Raster Fields to New Rasters dialog box is used to convert 
raster attributes to individual raster layers. 

 
 

The dialog box for converting raster attributes to raster layers (fig. 4-47) is used 
to identify the combined raster and the attributes to be converted to individual 
layers.  To carry out this function, follow these steps: 

 
1. Select a raster containing the attributes that you would like to convert to 

new raster layers (this will generally be a combined raster).   Use the 
drop-down menu to the right of Combine Raster Name to select the 
combined raster.  All attributes contained within the combined raster will 
then appear in the lower portion of the dialog box (see fig. 4-48).    

 
2. Enter a New Raster Name in the appropriate cell of the second column 

that corresponds to the attribute of interest as shown in figure 4-48.   
 

Note:  Remember that the name is limited to eight characters or less.  In 
addition, the file name you select should not contain any spaces, leading 
numbers, or special characters (such as `~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

  
3. The remaining three columns of the dialog box (Raster, Join Raster, and 

Join Additional Attributes) are optional and can be used to join any 
additional attributes to the new raster layer.  Typically, these are ancillary 
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attributes that are used for descriptive purposes, such as a descriptive 
name that corresponds to a particular raster value.  These additional 
attributes are generally included within the combined layer or in a layer 
that was used to create the combined layer.  To join additional attributes 
to the new raster layer, double click in the cell under Raster.  Select the 
raster layer containing the appropriate attributes from the drop-down 
menu (see fig. 4-48).  

 
Tip:  The raster must exist within your ArcMap project before it appears in the 
drop-down menu. 

 
4. Double click in the cell under Join Attribute and select the appropriate 

field from the drop-down menu that will be used to join the attributes to 
the new raster layer. This entry must correspond to the value of the new 
raster layer (see fig. 4-48).   

 
5. Double click in the cell under Additional Attributes.  Select all attributes 

from the drop-down menu by putting a check in the box corresponding 
to the appropriate attribute(s).   After entering all the appropriate 
information for a particular row of the dialog box, return to the first 
column and click on the box to check it. 

 
Tip:  New raster layers will be created only for those Raster Attributes 
containing a check mark. 
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Figure 4-48. The Raster Fields to New Rasters dialog box.  In this example, a 
new raster named “evtnew” is created from the “Ev_type_1” attribute from the 
combine layer.  The new raster layer will include an attribute labeled “Evt_name” 
which originates from the raster layer denoted as “ev_type_1”. 

 

 
6. Next save your work to a location of your choice by clicking on the browse 

button to the right of the Save Rasters to box.  You can select a new 
location or accept the default value that appears in the window.  Click Next 
to create the new rasters.  After processing is complete, the new raster 
layers will appear in ArcMap’s Table of Contents. 

 
 

At this point, you may decide to merge 
these treatment rasters BACK into their 

original counterparts.  This will create new 
input layers that you can run in FBAT or in 

the FRCC Mapping Tool to observe the 
effect of changes you have made. 
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4.5.8 Merge edited rasters with original rasters 

 
The Merge Edited Rasters with Original Rasters function is used to create a new 
raster layer made up of edited and non-edited data.  In other words, the edited 
data is “burned into” the non-edited data.  For example, post-burn data might be 
used to overwrite pre-burn data. 
 

Note:  The raster layers to be merged must exist in your ArcMap project before 
you can use this GIS function. 

 
1. Open the Area Change tool dialog box and select the radio button labeled 

Merge Edited Rasters with Original Rasters (fig. 4-49).  
 

 

 

Select radio button 
to merge rasters 

together 

Figure 4-49. Use the Merge Edited Rasters with Original Rasters 
radio button to open the Merge Edited Rasters dialog box and merge 
rasters. 

 
 

2. Click Next to open the Merge Edited Rasters dialog box (fig. 4-50). 
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Figure 4-50.  The Merge Edited Rasters dialog box.  In this example, the edited 
raster name “evtnew” is merged with the original raster named “ev_type_1” to 
produce a new raster named “evtfnl.” 
 

 
3. Identify a raster that contains edited values from the Edited Raster column 

(note: no selection is made at this time).  Double-click in the adjacent cell in 
the column labeled Edited Raster Attribute.  The Edited Raster Attributes 
column identifies the attribute that was edited; that is, the attribute that will 
be used to overwrite the attribute in the Target Raster.  Select the 
appropriate attribute contained within the Edited Raster box by using the 
associated drop-down menu.  

 
4. Identify the Target Raster layer from the drop-down menu by double clicking 

in the cell within the Target Raster column.  The target raster is the layer 
that will be changed by “burning” in the values from the Edited Raster. 

 
5. Now, select the Target Raster Attribute from the target raster that will be 

changed by the Edited Raster.  Double click in the cell within the Target 
Raster column and select the appropriate attribute from the drop-down 
menu.   

 
Tip:  Typically, Target Raster Attributes must match the Edited Raster Attributes. 

 
6. Enter a name for the Merged Raster Name in the last column.   
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Note:  Remember that the name is limited to eight characters or less.  In addition, 
the file name you select should not contain any spaces, leading numbers, or special 
characters (such as `~! @#$^()-+={ }[ ]|\?/:;”’< >,.).  Do not include an extension. 

 
7. After entering a name, return to the first column and check the box 

associated with the Edited Raster’s name.   Complete the same process for 
each set of raster layers that you want to merge. 

 
Note: Once again, be sure to follow the usual naming conventions for ACT. 

 
8. Identify an output folder for storing the new raster layers by using the 

browse button to the right of the “Save Rasters to” box.  Navigate to a 
directory of your choice and create a new folder.   

 
9. Lastly, click Finish.  The new raster layers will automatically appear in the 

ArcMap Table of Contents. 
 

We recommend that you save your ArcMap project at this time.  In addition, we 
recommend that you zoom into those pixels with values that were changed 
during the editing process.  Are the changes evident in each of the output layers?  
Toggle back and forth between the pre- and post change raster layers to 
compare pixel values that should have changed (note: be sure to use identical 
legends). 
 

 
. 
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Chapter 5: Troubleshooting ACT – Common Errors, 
Symptoms, and Solutions 
 

 
If ACT fails to produce a new raster layer, consider the following: 
 

Naming Conventions 
 

Remember that you do not need to add an extension, and the name is limited to 
eight characters or less.  In addition, the file name you select should not contain 
any spaces, leading numbers, or special characters (such as `~! @#$^()-+={ }[ 
]|\?/:;”’< >,.). 
 

 
Output Path 

 
The total length of the output path is limited to 80 characters.  In addition, 
names of folders within the path cannot contain spaces or special characters 
(such as `~! @#$^()-+={ }[ ]|\?/:;”’< >, .). 

 
 

To report a bug, please contact helpdesk@niftt.gov. 
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